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Create shows others will want to view again

Tips for Creating Better Slideshows



What I'm Going to Cover

* What is a Slideshow
e How to Get Started
e Slideshow Considerations



What is a Slideshow

* 1980s.A presentation of film transparencies
(slides) and projected onto a wall or screen.

* 1990s.The start of computers and digital
photography. Slideshows were a progression
of still images without effects or sound.

e 2000s. Slideshows took off. Came to mean a
full audiovisual presentation. Includes
soundtracks, video, stills, sound effects, &
special effects



GETTING
STARTED



Getting Started

* Who's Viewing the show (Target
Audience)?

* What are you trying to say (The
Message)?

* What emotional state are you trying to
create (tone of show)

* How will it be delivered? (Medium)



Getting Started

TARGET AUDIENCE

* Who is your Target Audience!?
> Kids
°> Family
> Technical

> Selling/Advertising



Getting Started

MESSAGE

* What are you trying to say?
* Means you need to know your audience



Getting Started

e Creating an emotional state in a show
> Matter of Music
° Pacing of the Show
° Visuals

* These 3 create a style and should agree
with each other for best results



Getting Started
DELIVERING THE MESSAGE

* Think about your presentation of
information to your audience

* Tie photos together most effectively from
the beginning with
> A reason and
> A theme

e The MOST misunderstood skill in good
slideshow making



Telling Your Story

A Slideshow needs to tell a Story
e Stories are Composed of a:

> Purpose
> Theme
o Story Line (i.e., Plot)

STORY (dfn)— A description of a sequence of events, or a
statement regarding the facts pertinent to a situation in
question



Telling the Story

* Complete stories: Beginning, Middle, End

> Tied together somehow with a creative
theme



Telling Your Story

Purpose
* What is the purpose of your Story!?

o Retirement
> Birthday
> Vacation

° etc



Telling Your Story

* ATheme is a broad idea or message
conveyed by how the story is told

> Color(s), Content, Format
> Technique, Concept, etc

* Build your THEME into your story line

> Makes for a more entertaining show

> More meaningful to the audience



Telling Your Story

* Beginning: An Introduction
> Explains the setting/premise

> Provides Info needed to learn what the story
IS



Telling Your Story

e The Middle: The Journey

> The majority of the show

> Takes Audience somewhere different from
where they started
Ups and downs
Twists

Fast and Slow



Telling Your Story

* The End: The conclusion
> Summarizes the Premise set at the beginning

> Changes how audience perceives what was
presented at the beginning



Telling Your Story

* Use Emotion to Convince your Audience

* Emotional responses are created by
Stories

* As info is provided, audience becomes
invested

* Slideshows of events people attended

> People almost relive the event

> More goes through their minds than the
pictures



Telling Your Story

* Music can enhance a show
° Proper Selection of music can be difficult
> Use Lyrical songs only when they enhance
show

Il fitting lyrics are distracting

Don’t use if the lyrics don’t blend well with the
show



Technique, Not Technology

» Keep the visuals Simple
o Utilize the KISS principle (Keep It Simple
Stupid)
> Be consistent in you visuals (e.g., theme(s))

> Be consistent in your captions
Font

Placement

> Be consistent with the type of music



IMAGES

Portrait & Landscape



IMAGES

PORTRAIT IMAGES
e Taller Than They are Wide
* Don’t Fit the Screen WVell

e Provide Lots of Unused Screen Real
Estate

e Placement
o Either Side

o Centered



IMAGES

PORTRAIT IMAGES
* Place portrait images side-by-side
> More Effective Use of Screen

° Images Should be the Same Size
Width
Height
> Generally, Don’t Mix Color with B&W

V — side-by-side



IMAGES

LANDSCAPE IMAGES

* Full screen — only image on the slide

e Less Than Full Screen
> Only image
> One 2 or more

Each sized and arranged to make full use of real
estate

aaaaaaaaaaaa



IMAGES

LANDSCAPE with PORTRAIT IMAGES

e Generally you won’t Mix these
 Balance on Screen as possible

o Same Size

> Same border/outline (same color)



BACKGROUND

* Full screen Image

> No need to consider the background

* Less Than Full Screen Image(s) Use A
> Colored Background
Black, white, color
> Gradient background (multi-color)
° Image (copy of foreground image or a new one)
Desaturated and/or

Blurred and/or

Reduced Opacity

V — images w/background



CAPTIONS



Captions

e Use Sparingly

e Use When It’s Important

* Never Describe the Visual

* For Info Unobtainable from the Visual

> Applies to a Visual with a voice-over

* Placement
 Black or white are the general rule for color

o Different colors need to be appropriate to theme



Caption Fonts

* Uniqueness
* Readability
* Personality
e 2-Font Rule



Caption Fonts

* Uniqueness
> Avoid Default Fonts (Everyone’s Seen Them)

* Readability
> How Easy is it to Read
o Serif Best For Lots Amounts of Text

o Sans Serif Best for Small Amounts of Text

V — captions type



Caption Fonts

* Personality

> The Feeling You Get When Looking at the
typeface

> Choose a typeface Applicable to Your Show
A Business Show Would Not Use a Kiddie typeface
Romantic Shows might use a Script typeface

» 2-Font Rule
> Choose 2 Fonts that Work Well Together
> Use Only Those 2 Fonts Thereafter
o Differentiate using Bold/ltalic (Don’t Overdo)



Caption Fonts

e The Shape of the Letter is Important
° Furthers the Message
° A Sale might need big bold letters

> A Legal item may need to convey stability,
reliability, strength. Comic Sans won’t do.

> AWedding show will not want to use courier
> A Child’s show won’t use a formal script

> Review fonts used by commercials, brochures,
ads



- MUSIC



Music

e For Emotion
* As a Background
» Matched to Visuals



Music

e For Emotion

> Be Mindful of Lyrics. If their story is different
than the visuals: audience confusion

> What Kind of Feeling are you trying to
create!

o Kinds of Music that remind of that feeling?



Music

As a Background

e Unless Promoting music, Don’t demand
Audience Attention

* Should effortlessly sit behind visuals

* Notice Lyrics in passing (focus is on visuals)



CONSIDERATIONS
FOR YOUR SHOW



Show Length

* Depends on Audience, Story, Message
» Basic Rule to follow: |0 — |8 minutes

> When attention “cliff”’ occurs after consistent
[same sensory pattern

° Vary Slide/Image

* Transition length

* Display time



Motion

e Utilize**Ken Burns Effect”
> A panning movement across an image

> Zooming in or out on an image
e Consider Including image rotation
* Helps add character/depth to image(s)



Motion

» Motion should have a reason
> Determine an image’s focal point of interest

> Don’t overuse
* Not every image needs to have motion
» Keep the amount of rotation small
* Panning/zooming/rotating is typically slow
e Change zooms

> Some in, some out, some hone



Music Considerations

* Shows set to different music types

> Country — Hard Rock
> Romantic — Classical
> Dance — Blue Grass

* What music works?
* What tone was set!

* What effects work with what music type



Music Selection/Type

* Music Must Agree with Show Pace
> Slow Paced Visuals Needs Slow-Feeling Music
> Fast Paced Visuals Needs Fast-Feeling Music

* The music should be appropriate to the

show

Looney tunes may be inappropriate for a serious
show

Slow music may not be appropriate for sporting
events

Classical music may not work for a birthday show
50’s tunes may not work for a today’s teen show



Music Tips

* Music

> Avoid switching tunes in the middle of a slide
* Fade music when transitioning sections

> Fade Out Current Section

o Fade In Next Section

V — music



PACE of Show

* Show Dependent

> Sport show Pace are vary from Nature shows
Sports are often fast paced

Nature show are often leisurely paced



Show Type

* Advertising Shows typically have no
content
> They often create a feel
> The images may not be shown for long
> Effects Prevail — Image Content unimportant
 Birthday/Memorial shows tweak
memories
> Emotive
° Image Displays are longer
° Image Content often Important



Good Design

 Balance
» Contrast
* Economy
o Unity



Good Design

 Balance
> Often Subjective.
o If it doesn’t look right, consider

Picture Placement
Lines

Where the Eye goes first



Good Design

e Contrast
> A black background is not always best
> Complementary colors (to image) work best

> A color from within the image may provide an
appropriate contrast to the image itself



Good Design

* Economy

> Nothing should exist on the page except what
conveys your idea

> Decorative elements should support the idea



Good Design

* Unity
o Stick to the Theme

Don’t change from one theme to another in mid-
show

Changing themes risks disharmony
> Be Consistent

If you use a flower for a background, you can
change the type of flower (it’s still a flower)

> A Great photo that doesn’t fit the theme will
seem out of place



Title Pages

* Use only what is necessary
> Don’t Use if there’s no Value Added

* Use a Title Page to introduce the Show or
a new section within a show.

e Use as a Transition/Separator for different
stories in the same show

* Use on top level text

> Need explanatory text, use a different page



Explanatory Pages

* This text is used to explain or setup what
is to follow, to set the stage, so-to-speak

e Static Text
e Scrolling



Explanatory Pages

o Static Text.

> Use a new slide if there’s more easily readable
text than can fit on one page.

Read the text aloud and time how long it takes.
Reading w/o vocalization may give shorter times
than necessary

Set slide time to the time required to read the text



Explanatory Pages

e Scrolling Text
> A page of text or more

> Provides a way to display lots of text on a
single slide

> On test runs, read the text aloud as the text
is scrolled on-screen. Adjust the slide time (or
scroll speed) to a comfortable reading pace



Explanatory Pages

* Background of text

> Sometimes, enhanced contrast required for
easier to read text

> Add a background
> Use a background different than the show
> Adjust the background

o> Add an outline and/or shadow to the text



START of Show

* Use one+ slides to Begin the Show
e Music For Start

> Same Tune
o Different Tune



END of Show

* Have a slide that flags the end of the
story/show

e Slide can either text-based, an image or
set of images, or both that indicate the
conclusion

* Music, if used, should also fade away

> The end/conclusion may use a different music
track from the rest of the show



Transitions

e Used for moving from
> One image to next image
> One slide to next slides
» Keep transitions variety to a minimum

> Constant Change can be distracting
Viewer may wonder what special effect

Attention is not on the show

— transition use



Transitions

* Unproffessional look: Using many different
transitions
° Inexperienced show creator

o |s tiring/jarring/confusing to the viewer



Transitions

» Use of different transitions
> Change tone / tenor of the show
° Indicate a change story content
e Match transition Style to Show
o Sedate transitions for sedate shows

o Fast transitions for fast shows



Transitions

» Use appropriate transitions
> Good reason to us different transitions

» Consider transition of one image to next
° |s it a good fit?
> Does it make sense?

Transition from that woman to dog a good idea!



Transitions — CUT

e MOVIES: Most often used transition

> Movies have other motion that can make cut
to a new segment less distracting than with
single image

o STILL IMAGES: Used rarely

° In image-based shows, Coordinated with
music beat/audio is less jarring & can help
guide viewer’s understanding of what’s going
on in show



Transitions — Crossfade (pissolve)

e MOVIES: Indicate passage of time
o STILL IMAGES: Most often used transition

> Creates a soft barrier between slides/images
to avoid shocking the viewer

> More polished appearance compared to cut
> Longer cross-fades add “dreamier” view

> Too long a cross-fade can lead to viewer
frustration (too much time getting to next
image!)



Techniques

 Fade to Black,White, Color, or Image
> Provides a break in flow of show

> A cue indicating something is changing

VVVVVVV



Techniques

 Transition Time Between
Images/Slide/Effect
> Depends on Type of Show (audience)
> Depends on Show Pace

> Depends on how many images displayed at
once



Techniques

e Consider Safe Zone vs Full Screen

o Safe zone is area inside of overscan
0% (top and bottom), 20% (both sides)

> Older TVs have a cropped region

Original manufacturing tolerances meant that signal
instability would create fuzzy or blank zones at
screen edges

The cropped region ensured area of good visual
quality

Some newer TVs, despite excellent video signal
quality, still utilize this overscan region



Slideshows Synopis

* What Slideshows are
o Stills/Videos/Special Effects/Music

e Creating a slideshow

> Audience/Message/Tone/Medium
* Additional Tips

° Images/Captions/Music/Transitions



S I i d €S h ow P I"Og rams (not comprehensive)

e Photodex — Proshow Gold/Producer

e Lightroom

e Adobe DVD Encore

e Microsoft Photo Story

* Magic PhotoStory

e StoryRock My Memories Suite

e Corel Digital Studio 2010

e WonderShare Software DVD SlideShow Builder
e CyberLink Corp Cyberlink MediaShow
* IncrediTools inAlbum

e ArcSoft DVD Slideshow

* Whsoft Pictures ToExe

e Etinysoft Photo MovieTheater



